Verify and ldentify Packet Loss in the WAN
for SD-WAN
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Introduction

This document describes how to identify and collect data when traffic has loss across the WAN but
no drops are seen on the SD-WAN Edge.

Prerequisites

Requirements
Cisco recommends that you have knowledge of these topics:

- Cisco Software-Defined Wide Area Network (SD-WAN)
- Embedded Packet Capture or vManage Packet Capture
- Wireshark

- Microsoft Excel

Components Used

The information in this document is based on these software and hardware versions:

- C8000V version 17.03.04
- vManage version 20.3.4
- Wireshark version 2.6.3
The information in this document was created from the devices in a specific lab environment. All of

the devices used in this document started with a cleared (default) configuration. If your network is
live, ensure that you understand the potential impact of any command.



Background

In order to assist with this challenge, the steps described in this doc shows how to mark specific
traffic with Differentiated Services Code Point (DSCP) to help to identify the desired packets.
DSCP can be used to identify the traffic since this value is copied from the inner packet header to
the IPsec header. Once the desired packets are identified, it shows how to match the traffic across
two WAN captures to ensure traffic made it from source to destination.

Two single router sites are used to demonstrate this troubleshoot technique. In this case, ICMP
traffic from 10.0.0.10 to 10.0.2.10 in the form of 100 pings as shown in the image. There is no loss
in this example but this same troubleshoot technique is used in the case where there is a loss to
identify it.

10.0.0.10 ; « 192.168.23.149 192.168.28.240 10.0.2.10
'V 2y,
4.9 4.9
cEdge1 cEdge3

Troubleshoot Process

Overview Process

1. For the traffic traced across the WAN, an Access List (ACL) (or centralized policy) is needed
to mark traffic with some unused DSCP value. In this example, DSCP 27 is used.

2. Once the traffic is marked, embedded packet capture is used to capture the packets on the
transport interface of the source and destination router.

Note: vManage packet capture can also be used although there is a limitation of 5MB of data
or 5 minutes of runtime.

1. After the captures are taken, open them in Wireshark to view.
2. The filter is applied in Wireshark to show which packets are desired and then they are

compared.
3. Microsoft Excel is used for large captures to ensure accuracy.

Mark the Desired traffic with DSCP

An access-list such as the example Is configured on the source router (cEdgel in this example)
and applied on the interface in the SD-WAN portion of the router config as shown.

An optional counter is applied to verify that traffic hits the policy as expected. This can be checked



with the command show sdwan policy access-list-counters.

policy

access-1list mark_dscp_27
sequence 10

match

source-ip 10.0.0.10/32
destination-ip 10.0.2.10/32
!

action accept

count MARK_DSCP_27_COUNT (optional counter to verify packets that hit the policy)
set

dscp 27

!

1

1

default-action accept

sdwan
interface GigabitEthernet3
access-list mark _dscp_27 in

Capture the Traffic with the Embedded Capture

Note: How to configure an embedded packet capture in Cisco I0S XE to capture the
encrypted packets which traverse the WAN, navigate to Embedded Packet Capture for
Cisco 10S and Cisco I0S XE Configuration Example

Note: An ACL must be used to limit the EPC on the WAN as there could be more than the
1000 PPS rate-limit for the EPC.

Example

An ACL is configured on cEdgel and cEdge3 since traffic is only checked in the direction of
source to destination in this example.

Note: The WAN IP addresses are used to filter the capture. There are multiple outputs which
can be used to identify the path the traffic takes so that the correct WAN IPs can be
identified for the ACL filter. The commands which can be used to generate this output are
the show sdwan app-fwd cflowd flows and show sdwan policy service path. Please,
navigate to Conditional Packet Trace for debug condition.

ip access-1list extended CAP-Filter
10 permit ip host 192.168.23.149 host 192.168.28.240

At this point, the captures are started on both routers and 100 pings are sent across the overlay.

#ping vrf 10 10.0.2.10 rep 100
Type escape sequence to abort.
Sending 100, 100-byte ICMP Echos to 10.0.2.10, timeout is 2 seconds:


https://www.cisco.com/c/en/us/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/en/us/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/en/us/support/docs/content-networking/adaptive-session-redundancy-asr/117858-technote-asr-00.html

Success rate is 100 percent (100/100), round-trip min/avg/max = 1/1/4 ms

After the captures are stopped and collected from both routers, they need to be opened in
Wireshark to view them.

Analysis through Wireshark

Once the cEdgel capture is opened in Wireshark it is seen that all the traffic is encrypted and it is
not easy to decipher which packets are the pings which were sent.
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n 192.168.28.288 e 178 Default 12388
M 03, 103168, 38388 o 17 Befault 12388
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Filter this capture with a display filter ip.dsfield.dscp == 27, it is seen that only 100 packets are
displayed at the bottom of the screen and it is seen that the DSCP column value all shows 27.

iZfasan

B et dhep = I7 <] =]+
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451 55.441963  192.168.23.149 197,168, 28. 288 e 176 n 12386 = 12487 Len=134
AST 55445576 197.168.23.145 192, 164.38. 240 e 76 mw 12386 = 12487 Len=1M4
451 55448566 192.168.71.149 192.164.26. 240 e 17 n 12086 < 13407 Len=1M
454 55, 450965 192,168, 20,145 192,160.20.240 e 176 7 12086 + 33407 LensiM
455 S5 ASIGEL  107.148.10.048 193.168.38. 240 we 7% n 1236 =+ 12437 Len=1M4
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459 55.457968  192.168.73.149 197164 18. 260 o 176 7 12386 = 12487 Lenn134
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462 55,460965  192.168.23,149 192,169.28.240 e 176 7 12396 = 13407 Len-1
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Frame a31; 176 bytes on wire (1499 bits), 176 bytes captured (1499 bits)
Eabarnet 17, Sre: Vhesre_Bhiaf 48 (00:30: 382453, Dut: Weare BHie2:57 (00:30:56:B4e2:b7)
Internet Protocol Versdon &, Src: 192.168.25.149, Dat: 192.168. 75,240
User Datagras Protocsl, dre Poce: 13584, Dut Pert: 13687
Data (134 bytes)
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@ 7 capan
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In some cases where DSCP value is maintained across the WAN, the same filter can be used on
the destination capture.

In other cases, this is not possible such as a situation where DSCP value is cleared across a
public-internet connection.



Filter the Desired Traffic by ESP Sequence

In either case, the traffic can be identified with the ESP sequence numbers.

To see the ESP sequence numbers in the packet, right click on the capture and choose Decode

as as shown.

Mark/Unmark Packet

Ignore/Unignore Packet
Set/Unset Time Reference

Time Shift...

Packet Comments
Edit Resolved Name

Apply as Filter
Prepare as Filter
Conversation Filter

Colorize Conversation
SCTP

Follow

Copy

Protocol Preferences

Show Packet in New Window

Ctrl+M
Ctrl+D
Ctrl+T

Ctrl+Shift+T
b

12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386

Select the Current field dropdown menu and in that field type UDPENCAP or select it from the

dropdown.



M Wireshark - Decode As...

Field Value Type Default Current

UDP port 12386 Integer, base 10 (none) |(none)

3GPP2 A1
A1
ACDR
ACtrace
ADP
ADwin
ALC

AMP

o] oo o [ | [0

Select the OK once this is completed.

M Wireshark - Decode As...

Field Value Type Default Current
UDP port 12386 Integer, base 10 (none) UDPENCAP

Within the Wireshark Packet Details section, expand the Encapsulating Security Payload
portion of the packet to see ESP Sequence.



A7Q B8 ARRGTR 147 1AR 23 144 142 1AR 2R 244 Fsp 17/

> Frame 464: 176 bytes on wire (1408 bits), 176 bytes captured (1488 bits)

> Ethernet II, Src: VMware_84:af:45 (©0:50:56:84:af:45), Dst: VMware_84:e2:b7 (00:50:56:84:e2:b7)
Internet Protocol Version 4, Src: 192.168.23.149, Dst: 192.168.28.240

> User Datagram Protocol, Src Port: 12386, Dst Port: 12487

UDP Encapsulation of IPsec Packets

Encapsulating Security Payload

ESP Sequence: 319

Right click on ESP Sequence and choose apply as column so the ESP Sequence can be seen
as a column in the Packet List section at the top portion of the Wireshark screen.

456 55.4 ESP
457 55. Expand Subtrees ESP
458 55.¢ Collapse Subtrees ESP
459 55.¢ Expand Al ESP
Fa
Dl R Collapse All ESP
461 55. ESP
462 55. Apply as Column Ctrl+Shift+| ESP
463 55. ESP
464 55.¢ Apply as Filter > ESP
465 55.¢ Prepare as Filter » ESP
466 55.4 ESP
467 55.2 Conversation Filter » ESP
468 55.¢ Colorize with Filter » ESP
469 55.¢ Follow b ESP
470 55.4 ESP
471 55.¢ Copy > ESP
472 55.¢ ESP
473 55.¢ Show Packet Bytes... Ctrl+Shift+0 ESP
474 55.4 Export Packet Bytes... Ctrl+Shift+X ESP
Wiki Protocol Page -
Frame 464: 176 byt ) ) 8 bits)
Ethernet II, Src: ' Filter Field Reference e _84:e2:b7 (@
Internet Protocol Protocol Preferences ’ .240
User Datagram Prot:
UDP Encapsulation { DECOdEAS... Ctl’l*Shift*U
Encapsulating Secu Go to Linked Packet
——— "  Packet in New Window
ESP Sequence: 3L

Note: The ESP SPI for the packets on cEdgelis 0x040001dc. This is used for a filter on the
destination capture.



> Frame 464: 176 bytes on wire (1408 bits), 176 bytes captured (1408 bits)
Ethernet II, Src: VMware_84:af:45 (@0:50:56:84:af:45), Dst: VMware_84:e2:b7
> Internet Protocol Version 4, Src: 192.168.23.149, Dst: 192.168.28.240
User Datagram Protocol, Src Port: 12386, Dst Port: 12407
UDP Encapsulation of IPsec Packets

ESP SPI: @x@40001dc (67109340

ESP Sequence: 319

Open the destination capture, repeat the steps to decode as UDPENCAP, and display the ESP
Sequence numbers in the packets.

Once the packets display the ESP Sequence number, the ESP SPI from the first capture can be
used as a filter on the second capture to display only the traffic within that SPI that matches the
desired traffic.

Notice that the packet sequence numbers that match both have DSCP 27 marked.

[ — - - a
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e X7 ol
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be ey st Isor-o m:“] 192.168.78, 260 e 175 nz 7 £ (ST
e e = :,,HL“.L,«] 162.148.38. 340 e M " 37 5 (S
o e 27 = st - 17 N 27 £5# (5P
5 { 3 192,148,28, 260 rse e ns 3 5 (SR
e T L Thhe 162.148.38. 306 e 1 06 27 [T
e oz o '” """";:] 197.168.28. 240 ' 175 nz 7 £ (ST
b s ;, = :wr_‘ um“‘] 97,148, 38. 268 173 ™ e 7 (ST
= S et e Lprprepe 192,148,208, 340 e ™ ne P (Pl
®  mnm = 192,148.28. 240 e 174 20 37 5# (5P
4 . Lot :m m; 162.148.38. 306 e 1 3 2 [
i 19216828, 200 s me o £ (Sriel
n et
: '::: o :i ::'r: ::] 192.168.28. 240 e 176 w S (S
% [ = Iwmm;' 192,148, 20, 240 (] e P £ (ST
192.140.20. 200 e e 0 a7 58 (5P
pre il E5F: (FT=bibinlic) 193,148,280, 268 (373 1 3 L e
« < »
Frame 4311 176 bytes on wire (1608 BIRs), 176 Bytes capfured (L608 Bits) Prum 8431 176 byes o wire (19 BiLa]. 176 byoes Captured (1000 WLt2)
Etheraet II, Srcn Veare S4iaf i85 (8050156184000 td5], D3ts Viare BA1e2iB7 (01501561B4162107) Ethernat 1, Sre: Vhears B4:af:a3 (00:38:36:88:a7145), DiR: Wieare_B4: 7 (003056 B4 eTiBT)
Intaratt Protocol Verstos 4, Srci I90.160.20.140Dats 192.160.20. 340 Tunernat roocsl Versian 4, Srct IE.148.33, 50, Buts 192,108, 3. 508
User Outagram Protocal, Src Port: 31386, Dut Prts 12607 User Datagram Protocel, Sre fort: 12386, Ost Port: 10407
1OF Eacapiulition of 1Piec Packets - W# Incapsulation of IPsec Packets
- rcapralating Secerity Puylosd
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This comparison can be done in Wireshark manually or Microsoft Excel can be used to do this
comparison.

In order to use Microsoft Excel to compare, it is necessary to slice both captures to contain only
packets which are in both captures.

In the source capture, the first relevant packet has ESP sequence 306 and that corresponds to
packet number 451.

A carg
Am 7 ® T RBReEZF LS EaAQqH
[ Tip.dsfield.dscp == 27 [X] -] +
Mo. Time Source Destination Protocol  Length ESP Sequence Different s
[ 451 55.441963 192.168.23.149 192.168.28.248 ESP 176 306 27

452 55.445976 192.168.23.149 192.168.28.248 ESP 176 307 27

453 55.448966 192.168.23.149 192.168.28.248 ESP 176 3es8 27

454 55.450965 192.168.23.149 192.168.28.240 ESP 176 309 27

455 55.452964 192.168.23.149 192.168.28.240 ESP 176 31e 27

456 55.454963 192.168.23.149 1592.168.28.248 ESP 176 311 27

457 55.455970 192.168.23.149 192.168.28.240 ESP 176 312 27

458 55.456977 192.168.23.149 192.168.28.248 ESP 176 313 27



The last relevant packet in the source capture has ESP sequence 405 and is packet number 550.

548 55.608962
549 55.609969
55 55.61e9c8

192.168.23.149
192.168.23.149
192.168.23.149

192.
192.
192.

168.28.240
168.28.248
168.28.248

ESP
ESP
ESP

176
176
176

403 27
404 27
4@s5 27

In the destination capture, the first relevant packet corresponds to the source capture with ESP
Sequence 306 but in this capture is packet 463.

461 60.522028
462 60.715026
463 60.999003
464 61.0030e6

The last relevant packet is also present with ESP Sequence 405 and it is packet 564.

5bE bl.1lb5U>Z
561 61.166043
562 61.166043
563 61.431029
564 61.584021

192,
192.
192.
192.
192.

192.168.23.149
192.168.23.149
192.168.23.149
192.168.23.149

1bd.25.149
168.23.149
168.23.149
168.23.149
168.23.149

192,
192.
192.
192.
192.

192.168.28.240
192.168.28.240
192.168.28.240
192.168.28.240

ESP
ESP
ESP
ESP

1bbi. 25. 298 ESH
168.28.240 ESP
168.28.240 ESP
168.28.240 ESP
168.28.2408 ESP

1/6
176
176
168
175

168
175
176
176

The first capture must now be sliced to include only relevant packets.

Navigate to File > Export Packet Dissections > As CSV...

407 Class S¢
498 Class S¢
306 27
387 27

483 2/
484 27
4e5 27
489 Class 5S¢
410 Class St

A CAP.pcap
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
Open Ctrl+0 EP S SE/aaQaqH
Open Recent »
Merge... Destination Protocol Length E
Import from Hex Dump... 149 192.168.28.240 ESP 176
Close Ctrl+W 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
Save Ctrl+S 149 192.168.28.240 ESP 176
Save As Ctrl+Shift+S 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
File Set » 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
Export Specified Packets... 149 192.168.28.240 ESP 176
Export Packet Dissections 4 As Plain Text... +240 ESP 176
_ .240 ESP 176
Export Packet Bytes... Ctrl+Shift+X As CSV... 240 ESp 176
Export PDUs to File... As "C" Arrays... .240 ESP 176
Export TLS Session Kevys... .240 ESP 176
po ession Reys AsPSMLXML.. | 240 — .
Export Object »
port Phyecs AsPDMLXML..  |.240 ESP 176
Print... Ctrl+P As JSON... -240 ESP 176
. 240 ESP 176
Quit Ctr+Q 149 192.168.28.240 ESP 176
YU TOVOTOL L 100y 149 192.168.28.240 ESP 176
548 55.608962 192.168.23.149 192.168.28.240 ESP 176

Select Captured and Range and in the Range field type the range from the first relevant packet to
the last relevant packet.



Enter a file name in the File Name field and click Save.

Remove Ignored packets 0 0

Repeat the same process on capture 2 for the relevant packets.

M Wireshark . Export Packet Dissections X
Savein: | [l Desktop vi @ F 2 @A~
* Name B Status Date modified
No items match your search.
Quick access
Desktop
|
Libraries
This PC
9 < >
Network
File name: CAP1_slice v Save
Saveastype:  CSV (Comma Separated Values summary) (".cs\ Cancel
Help |
Packet Range Pack
@® Captured O Displayed vl
(O All packets 830 100 E
(O Selected packet 1 * Pz
Marked packets 0 0 -!
First to last marked 0 0 .
(® Range: |451-550 100 100 [P
W]



Ml Wireshark « Export Packet Dissections "
Snrn.:-l.':'eﬂ:mp .,: a3 °m

* Hame Status Duate rmodified

M ernd sl our fearch,
Cuick acoess

P4
Diesitop

= |
Librasies

4

This PC

¢ ;

. File names: [L‘API_iDt '-'l I Sare I
Save &3 Bype: CSV Comma Separsbed Values summary) "o Cancel
Helg
Packet Rarge Fuacke
® Captured () Desplaryed EHra
() Ml packets 04 - E
() Saleched packet 1 i s
Wark e packets
A
Frsl 10 Lasl marked
(®) Range: [453.564 02 Lirs
Remgve kgrored packets DE"
Open both CSV files in Microsoft Excel.
On the source capture CSV, save as an XLSX format.
Save As
@ Recent 'Im% Desktop
Cisco 'Excel Waorkbook (*xlsx) -i Fa Save

At the bottom of the screen, select the + symbol to add another sheet. Name it CAP2_slice.

' ! 485 55.51497 192.168.2: 192.168.2L ESP 176 340 27 ESP (SP1=0x040001dc)

i | 486 55.51697 192.168.2:192.168.2L ESP 176 341 27 ESP (SP1=0x040001dc)

| | 487 55.51796 192.168.2:192.168.2E ESP 176 342 27 ESP (SPI=0x040001dc)
CAP1_slice O

Open the CAP2 CSV file and press CTRL + a to select all and CTRL + c to copy it.



Navigate to the CAP1_slice.xIsx file and on the second tab for CAP2_slice, paste (CTRL + v) the
copied information into the cell A1l.



File Home

o & Cut

o [BCopy ~

Paste

Insert

Fage Layout

Calibn

w43 Farmat Fainter

Clpboard

B
i

=

I

o s W b o P e

EEUERRUERESEEBNEREER

F]

CAP1_slice

I

| CAPZ slice |

Formulas

C

1]
il

CAPT_sheesxb = Say

View Help
#r - 3 Wrap Text General -
£2 3= E‘j Merge & Center = i = % b ".;S E'S
Algnment ] Humber 5
H | 1 K L ]



Time

" - e

1 No

2 463 60.99901 192.168.2:192.168.2{ ESP
3 464 61.00301 192.168.2:192.168.2{ ESP
4 465 61.00506 192.168.2:192.168.2{ ESP
5| 466 61.00706 192.168.2:192.168.2{ ESP
6 | 467 61.00905 192.168.2:192.168.2¢ ESP
7] 468 61.01006 192.168.2:192.168.2{ ESP
8 | 469 61.01105 192.168.2:152.168.2¢ ESP
9 | 470 61.01305 192.168.2:192.168.2¢ ESP
10 471 61.01406 192.168.2:152.168.2¢ ESP
1 472 61.01606 192.168.2:192.168.2f ESP
12] 473 61.01806 192.168.2:192.168.2¢ ESP
13 474 61.02106 192.168.2:192.168.2¢ ESP
14 475 61.02205 192.168.2:192.168.2f ESP
15 476 61.02306 192.168.2:192.168.2¢ ESP
16 477 61.02506 192.168.2:192.168.2{ ESP
17: 478 61.02605 192.168.2:192.168.2¢ ESP
18 479 61.02805 192.168.2:192.168.2{ ESP
19: 480 61.02906 192.168.2:192.168.2¢L ESP
20| 481 61.02906 192.168.2:192.168.2{ ESP
21 | 482 61.03005 192.168.2:192.168.2{ ESP
22 | 483 61.03206 192.168.2:192.168.2{ ESP
23 484 61.03306 192.168.2:192.168.2¢ ESP
24 485 61.03505 192.168.2:192.168.2{ ESP
25 | 486 61.03606 192.168.2:192.168.2{ ESP
26 | 487 61.03905 192.168.2:192.168.2¢ ESP
27 | 488 61.04105 192.168.2:192.168.2{ ESP
28 | 489 61.04206 192.168.2:192.168.2¢ ESP
29| 450 61.04406 192.168.2:192.168.2¢ ESP
30 | 491 61.04606 192.168.2:192.168.2¢ ESP
31 492 61.06305 192.168.2:192.168.2¢ ESP
32| 493 61.06505 192.168.2:152.168.2¢ ESP
33| 494 61.06705 192.168.2:192.168.2¢ ESP
34 | 495 61.06905 192.168.2:192.168.2¢ ESP
35 496 61.07105 192.168.2:192.168.2¢ ESP
36: 497 61.07105 192.168.2:192.168.2¢ ESP

-
o

ANno

Navigate back to CAP1_slice sheet and make a new column called

£4 ATANE ANA 1£0 A71A 160 ACren

COMPARE_ESP_SEQUENCE.

1 |No. Time Source  Destinatic Protocol Length  ESP Seque Differenti Source Po Destinatic Info
2 451 55.44196 192.168.2:192.168.2¢ ESP 176 306

3 452 55.44598 192.168.2:192.168.2¢ ESP 176 307

B
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Sequence Number
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)

FERIE P A AR el

-

Source  DestinaticProtocol Length  ESP Seque Differenti Source Po Destinatic Info

‘Sequence‘N
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI1=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI1=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI1=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI1=0x040001dc)

ren CNnl—NanAnnNa ==\

P a | R

' COMPARE_ESP_SEQUENCE

As the ESP Sequence number is in Column G, compose a VLOOKUP command as shown to
compare the two sheets to ensure that everything in Column G on the source is in Column G on
the destination.

=IF(ISNA(VLOOKUP(G2,CAP2_slice!G:G,1,FALSE)),"MISSING","PRESENT")

x v I =IF{ISNAIVLOOKUR|G2,CAPZ_slice !G.G,1,FALSE)),"MISSING","PRESENT")
B C o E F G H I 1
‘ime Source  Destinatic Protocol  Length .ESP Segu(.DII'fElEn‘tl Source Po Destinatic Info
5544196 152.168.2: 192,168, 2{ ESP 176] 206] 7
55.44598 19216827 192.168 2 ESP 176 07 27

L

M
Sequence Number
ESP [SPI=0x0400016)
ESP (SPI=0x040001de)

N

COMPA | ESP_SEQUENCE

u v w X

|=IFI ISNAIVLOOKUP(G2,CAP_slicelG:G,1,FALSE)),"MISSING™,"PRESENT")

After Enter is selected the word PRESENT is displayed. This means that the packet with ESP
Sequence 306 is present in the second sheet. This is significant because it means that the packet



made it from the source to the destination.

| A | B | € | o | E | F | 6 | H | | | » | Kk | ¢ | M | N | o |BNP Q | R
1 |No. Time Source  Destinatic Protocol Length  ESP Seque Differenti Source Po Destinatic info Sequence Number COMPE ~ | ESP_SEQUENCE
2 451 55.44196 192.168.2:192.168.26 ESP 176 306 27 ESP (SPI=0x040001dc) PRESENT

3| 452 55.44598 192.168.2: 192.168. 2L ESP 176 307 7 ESP (SPI=0x040001dc)

Select Column O Row 2 and hover over the bottom right corner of the green box around that cell.

N 0 P | Q R S
COMPARE_ESP_SEQUENCE
3

Select and hold, and drag the mouse down to copy this formula to the bottom of the cells which
have values.

X fe || =IF{ISNA(VLOOKUR(G2,CAP2_slice!G:G,1,FALSE]),"MISSING","PRESENT")
B C D E F G H | ] K L M M Q P Q R 5 T u v w

Time Source  Destimatic Protocol Length  ESP SequeDifferenti Source Po Destinatic Info Sequence Number COMPARE ESP_SEQUENCE

¥1 5544196 192.168.2: 192.168.2(ESP 176 306 7 ESP (SP1=0x040001dc) PRESENT

52 55.44598 192.168.2: 192.168.2EESP 176 307 27 ESP (SP=0n030001dc)

33 5544397 192.168.21 192.168. 26 ESP 176 308 27 ESP (SP1=0x040001dc)

3 5545097 192.168.2: 192.168.2E ESP 176 309 7 ESP (SPI=0x040001dc)

35 5545296 192.168.2: 192.168.2E ESP 176 310 27 ESP (SPI=0x040000dc)

36 55.45496 192.168.2: 192.168.2EESP 176 311 27 ESP [SP=0n040001dc)

37 55.45597 192.168.27 192.168.2E ESP 176 312 7 ESP (SPI=0x040001dc)

¥ 5545698 192.168.2: 192.168.2(ESP 176 313 7 ESP (5P1=0x040001dc)

59 55.45797 192.168.2: 192.168.2EESP 176 314 27 ESP (SP=0n020001dc)

30 55.45898 192.168.27 192.168.26ESP 176 315 27 ESP (SPI=0x040001dc)

31 55.45197 192.168.2: 192.168.2E ESP 176 316 7 ESP (SPI=0x040001dc)

52 55.46397 192.168.2: 192.168.2EESP 176 317 27 ESP (SP1=0x080001dc)

53 55.46596 192.168.2: 192.168.2¢ESP 176 318 27 ESP (SP1=0x040001dc)

¥ 5546697 192.168.27 192.168.2E ESP 176 319 7 ESP [SP1=0x040001dc)

35 5546796 192,168.2: 192.163.2E ESP 176 3 27 ESP | SPI=0x040001dc)

36 55.46996 192.168.2: 192.168.2EESP 176 n 27 ESP [SP=0n040001dc)

37 5547097 192.168.2% 192.168.2E ESP 176 322 27 ESP [SPI=0x040001dc)
2T DIUULT T ATLAVOLD LTLAUO. LLCOF armw 7% “r COF | IF I=UAsUUUAUL | .I'I\I:JCIUI 1
540 55.60496 192.168.27192.168.2 ESP 176 395 27 ESP (SPI=0x040001dc) _PRE.SENT
541 55.60596 192.168.2:192.168.2¢{ ESP 176 396 27 ESP (SPI=0x040001dc) PRESENT
542 55.60696 192.168.2:192.168.2{ ESP 176 397 27 ESP (SPI=0x040001dc) PRESENT
543 55.60696 192.168.2:192.168.2{ ESP 176 398 27 ESP (SPI=0x040001dc) PRESENT
544 55.60696 192.168.2:192.168.2{ ESP 176 399 27 ESP (SPI=0x040001dc) PRESENT
545 55.60796 192.168.2:192.168.2{ ESP 176 400 27 ESP (SPI=0x040001dc) PRESENT
546 55.60796 192.168.2:192.168.2 ESP 176 401 27 ESP (SPI=0x040001dc) _PRESENT_
547 55.60896 192.168.2:192.168.2{ ESP 176 402 27 ESP (SPI=0x040001dc) PRESENT
548 55.60896 192.168.2:192.168.2{ ESP 176 403 27 ESP (SPI=0x040001dc) PRESENT
549 55.60997 192.168.2:192.168.2{ ESP 176 404 27 ESP (SPI=0x040001dc) PRESENT
550 55.61096 192.168.2:192.168.2{ ESP 176 405 27 ESP (SPI=0x040001dc) PRESENT

Scroll back to the top of the sheet and click the COMPARE_ESP_SEQUENCE. Then select Sort
& Filter.

1 B | Normal Bad Good o fE | T Auosum

Fill ~

onal Formatas Neutral Calculation Check Cell 1= Insert Delete Format o
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Styles Cells
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Choose Filter from the dropdown menu.
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Sort & | Find & Analyz
Filter v |Select ~ Data

it 4] sotAtoz |

21 SortZto A

it| Custom Sort...
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Filter

1
A dropdown menu appears on the COMPARE_ESP_SEQUENCE column.

M N 0 P

{umber ‘ COMPA ~ l_ESP_SEQUENt
PRESENT
PRESENT
PRESENT

Click the dropdown menu on the COMPARE_ESP_SEQUENCE heading. Notice that in this
example, the only value shown is PRESENT. This means all the packets are present in both
captures.
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To create a problematic example, delete 10 packets from the CAP2_slice, to demonstrate how this
would work in a test where some missed packets are missing.

1 4/Z DLULDUD 19Z2.108.4: 192.108.2¢ ESV 1/0 310 27 ESF [dPI=UXU4uUUULac)
12 473 61.01806 192.168.2:192.168.2¢ ESP 176 316 27 ESP (SPI=0x040001dc)
13 474 _61.02106 192.168.2:192.168.2§ ESP 176 317 27 ESP (SPI=0x040001dc
14 475  61.02205 192.168.2:192.168.26 ESP ' 176 318 27| i ESP (SPI=0x040001d(
15 476 61.02306 192.168.2:192.163.26ESP 176 319 27 . ESP (SPI=0x040001d«
16 477 61.02506 192.168.2:192.168.28 ESP 176 320 27 » ESP (SPI=0x040001dk
17 478 61.02605 192.168.2:192.168.26ESP 176 321 27 , ESP (SPI=0x040001d
18 479 61.02805 192.168.2:192.168.26ESP 176 322 27 , ESP (SPI=0x040001d«
19 480 61.02906 192.168.2:192.168.2 ESP 176 323 27 _ ESP (SPI=0x040001d(
20 481 61.02906 192.168.2:192.168.2 ESP 176 324 27 » ESP (SPI=0x040001d(
21 482 61.03005 192.168.2:192.168.26ESP 176, 325 27 , ESP (SPI=0x040001dk
22 483 61.03206 192.168.2:192.168.26ESP 176 326 27 , ESP (SPI=0x040001d(
23 484 61.03306 192.168.2:192.168.26 ESP 176 327 27 . ESP (SPI=0x040001dk
24 485 61.03505 192.168.2:192.168.2¢ ESP 176 328 27 ESP (SPI=0x040001dc)
25 486 61.03606 192.168.25192.168.26 ESP 176 329 27 ESP (SPI=0x040001dc)
26 487 61.03905 192.168.2:192.168.2¢ ESP 176 330 27 ESP (SPI=0x040001dc)
27 488 61.04105 192.168.2:192.168.2¢ ESP 176 331 27 ESP (SPI=0x040001dc)
28 489 61.04206 192.168.2:192.168.2¢ ESP 176 332 27 ESP (SPI=0x040001dc)
29 430 61.04406 192.168.2:192.168.26ESP 176 333 27 ESP (SPI=0x040001dc)
30 491 61.04606 192.168.2192.168.26 ESP 176 334 27 ESP (SPI=0x040001dc)
31 492 61.06305 192.168.2:192.168.2¢ ESP 176 335 27 ESP (SPI=0x040001dc)
32 493 61.06505 192.168.2:192.168.2¢ ESP 176 336 27 ESP (SPI=0x040001dc)
33 434 61.06705 192.168.2:192.168.26ESP 176 337 27 ESP (SPI=0x040001dc)
34 495 61.06905 192.168.2:192.168.26ESP 176 338 27 ESP (SPI=0x040001dc)
35 496 61.07105 192.168.2:192.168.2 ESP 176 339 27 ESP (SPI=0x040001dc)
36 497 61.07105 192.168.2:192.168.2E ESP 176 340 27 ESP (SPI=0x040001dc)
37 498 61.07205 192.168.2:192.168.26ESP 176 341 27 ESP (SPI=0x040001dc)
38 499 61.07605 192.168.2192.168.26 ESP 176 342 27 ESP (SPI=0x040001dc)

CAP1slice | CAP2slice | (@



Navigate back to CAP1_slice sheet and now it is seen that there are 10 packets missing.

WS SIS B D R AN B AN LR arw e o L e r—wALTUT L LIE LT

460 55.45898 192.168.2:192.168.2f ESP 176 315 27 ESP (SPI1=0x040001dc) PRESENT
461 55.46197 192.168.2:192.168.2L ESP 176 316 27 ESP (SPI=0x040001dc) PRESENT
462 55.46397 192.168.2:192.168.2¢ ESP 176 317 27 ESP (SP1=0x040001dc) PRESENT
463 55.46596 192.168.2:192.168.2f ESP 176 318 27 ESP (SPI1=0x040001dc)
464 55.46697 192.168.2:192.168.2¢ ESP 176 319 27 ESP (SPI=0x040001dc)
465 55.46796 192.168.2:192.168.2{ ESP 176 320 27 ESP (SPI=0x040001dc)
466 55.46996 192.168.2: 192.168.2f ESP 176 321 27 ESP (SPI=0x040001dc)
467 55.47097 192.168.2:192.168.2¢ ESP 176 322 27 ESP (SPI=0x040001dc)
468 55.47198 192.168.2:192.168.2¢ ESP 176 323 27 ESP (SPI=0x040001dc)
469 55.47297 192.168.2: 192.168.2¢ ESP 176 324 27 ESP (SPI=0x040001dc)
470 55.47497 192.168.2:192.168.2¢ ESP 176 325 27 ESP (SPI=0x040001dc)
471 55.47597 192.168.2: 192.168.2¢ ESP 176 326 27 ESP (SPI1=0x040001dc)
472 55.47697 192.168.2: 192.168.2¢ ESP 176 327 27 ESP (SPI1=0x040001dc)
473 55.47896 192.168.2:192.168.2¢ ESP 176 328 27 ESP (SPI1=0x040001dc) PRESENT
474 55.48096 192.168.2:192.168.2¢ ESP 176 329 27 ESP (SPI1=0x040001dc) PRESENT

When the dropdown menu is selected on the COMPARE_ESP_SEQUENCE column, now it is
seen that there are MISSING packets also. This can be toggled to view only the MISSING
packets.
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Now only the missing packets are shown in the Excel sheet.
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Related Information

. Cisco Embedded Packet Capture

| B | C L |

Time Source  Destinatic Protocol Length
55.46596 192.168.2:192.168.28 ESP 176
55.46697 192.168.2:192.168.28 ESP 176
55.46796 192.168.2:192.168.2{ ESP 176
55.46996 192.168.2:192.168.2 ESP 176
55.47097 192.168.2:192.168.2 ESP 176
55.47198 192.168.2:192.168.28 ESP 176
55.47297 192.168.2:192.168.28 ESP 176
55.47497 192.168.2:192.168.2§ ESP 176
55.47597 192.168.2:192.168.2 ESP 176
55.47697 192.168.2:192.168.2¢ ESP 176

. Technical Support & Documentation - Cisco Systems
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ESP Seque- Differenti Source Po Destinatic Info

27
27
27
27
27
27
27
27
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ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)
ESP (SPI=0x040001dc)

Sequence Number

(8] P

'COMPA.T,_ESP_SEQI

MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING


https://www.cisco.com/c/en/us/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/en/us/support/index.html
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